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FAQ's

* |s this session being recorded? Yes

* Can | get a copy of the slides? Yes, we’ll email links to download materials after

the session has ended.
e Can we arrange a re-run for colleagues? Yes, just ask us.

 How can | ask questions? All lines are muted so please use the chat panel —if we

run out of time we will follow up with you.

'f A .' A ;+ ;.D 3 III

Unmute Stop Video Invite Manage Participants Polling Share Screen
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« Gold accredited partner to IBM, Predictive Solutions and Deep experience of applied advanced

DataRobot specialising in advanced analytics & Al analytics applications across sectors

. — Retail
technologies
— Healthcare/Pharma
* Work with open-source technologies (R, Python etc.) — Finance/Insurance
« Team each has 15 to 30+ years of experience working in — Media/Telecoms
— Utilities
the advanced and predictive analytics industry
— FMCG
6 — Charity/Housing/Government
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Prerequisites to this webinar: Understanding Linear Regression

* https://www.sv-europe.com/blog/introduction-to-linear-regression/
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SMART VISION

Introduction to linear regression

By Jarlath Quinn / 2 March 20

In classical statistics, linear regression is regarded as the ‘gateway to predictive modelling’ For decades students have been taught about
regression from theory to practice simply because it still one of the most versatile and simple ways to understand and predict the effect of key

factors on critical outcomes.
For instance, using regression you can:

« Estimate and predict outcomes such as revenue from sales, machine repair costs, traffic volumes or asset failure rates
» Predict what effect a change in advertising spend or price will have on your sales
« Understand the relative strength of different factors that influence your sales - do your sales depend more strongly on price or on

advertising volume?
With this two-part video, in less than 20 minutes, Jarlath Quinn illustrates:

« The fundamentals of correlation analysis and linear regression
+ How to build and interpret linear regression models in SPSS

« How to apply a regression model to make predictions

How to do linear regression in SPSS - video tutorial part one

The regression line is drawn
50 it that minimises the
differences between the

points and line itself
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Why are Moderation and Mediation analyses useful?

* In multiple linear regression we are often concerned with questions like “Does X
predict Y after controlling for other variables?”

* In such situations, the coefficients tell you the average effect of each predictor
holding others constant.

* Moderation and Mediation analysis drive deeper insights: allowing to you to find
out when something is related (moderation) and how it is related (mediation).

* Moderation analysis is usually multiple linear regression including an interaction
term.

* Maediation analysis is akin to multiple linear regression done in steps to test a
pathway (X > M = Y)

SMART VISION A SELECT INTERNATIONAL COMPANY
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PROCESS is an observed variable OLS and logistic regression path analysis modeling tool. It is widely used through the social
business, and heaith sciences for estimating direct and indirect effects in single and multiple mediator models (parallel and
serial), two and three way interactions in moderation models along with simple slopes and regions of significance for probing
interactions, and conditional indirect effects in moderated mediation models with a single or multiple mediators or moderators.
The use of PROCESS Is described and documented in /nt ’

published by The Guilford Press. PROCESS was written by And

Installing Moderation and Mediation Analysis for

IBM SPSS Statistics
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Installing Moderation and Mediation Analysis in IBM SPSS Statistics

* Moderation and Mediation Analysis is NOT available as standard functionality in SPSS

Statistics.

* Fortunately, it is available as a free downloadable package developed by Andrew F.

Hayes Ph.D.

* Dr Hayes, created a package for SPSS (and other statistical software) called PROCESS,

and includes instructions on how install the software which can be found here:

* http://www.processmacro.org/

SMART VISION A SELECT INTERNATIONAL COMPANY
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The processmacro.org website

DOWNLOAD WORKSHOPS PAPERS FAQ VERSION HISTORY

The PROCESS macro for SPSS, SAS, and R ¢ [in (=

~vo3g <2277

l | |

PROCESS is a regression-based modeling tool. It is widely used through the social, business, and health sciences
for estimating direct and indirect effects in single and multiple mediator models (parallel and serial), two and
three way interactions in moderation models along with simple slopes and regions of significance for probing
interactions, and conditional indirect effects in moderated mediation models with a single or multiple mediators
or moderators. New features for ordinary regression analysis as dealing with random measurement error in
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SMARTVISION

A SELECT INTERNATIONAL COMPANY



UNIVERSITY OF
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CALGARY

Search Canadian Centre for Research Analysis and Metho... Q

Canadian Centre for Research Analysis and Methods (CCRAM) HASKAYNE SCHOOL OF BUSINESS

Meet our experts

----------------- FROCESS Procedure for $PS3 Version 4.2

n by Andrev F. Hayes,
on available in Hayes

OUTCOME VARIABLE:
Justify

ar1

Model Sumnary
R 2 F arz »
L4962 L2463 6609 22.5430 3.0000  207.0000 .0000

Hodel

constant
£

rane
skeptic
Ine_1

Product terms key:
Intl frame  x skepric

highest order unconditional interaction(s):
1 del at2 p
13.2503 1.0000  207.0000 L0003
frame  (X)
skeptic (V)

cts of the focal predictor at values of the NOAerator(s):

Computational Tools and Aids

PROCESS macro for SPSS, SAS, and R

PROCESS is a computational tool invented by CCRAM expert Andrew F. Hayes. It is freely-available for SPSS, SAS, and R,
and has become widely used throughout the behavioral sciences as well as in business research, medicine, and public

health for easing the estimation of effects in mediation, moderation, and conditional process analysis.

Version 5.0 is now available! The SPSS version of PROCESS v5.0 requires SPSS version 26 or later. The SPSS GUI for

PROCESS v5.0 is now an extensions file (*.spe) rather than a custom dialog builder file (.spv).

Take a class on the use of PROCESS Download PROCESS v5.0




BN e

Steps to install the PROCESS dialog

Download the Process zip file (http://www.processmacro.org)
Unzip the file in a location of your choice
Start SPSS in Run as Administrator mode (right-click the icon)

Within SPSS, go to

To use the new procedure, navigate to

— Analyze > Regression > PROCESS

SMARTVISION

-

Best match I
7= IBM SPSS Statistics

|®

/) App

£ Run as administrator

Apps Open file location

.- IBM SPSS Statistics ¢ 3% Unpin from taskbar
" Early Access

<P Pin to Start

. IBM SPSS Amos 27 ¢

T Uninstall

. IBM SPSS Amos 27 ¢

X Remove from device history

Extensions > Utilities > Install Custom Dialog

Extensions  Window Help
Extension Hub...
Install Local Extension Bundle.
Custom Dialog Builder for Extensions
[E3 Benfords Law Analysis

Utilities >
[#] Descriptive Statistics Example
45 8 Cler
37 15
34 15

t & salary ¢ salbegin ¢ job

-l &an Annn tan 7EN

Create Extension Bundle...
Edit Extension Bundles
Custom Dialog Builder (Compatibility mode)..

Cler Install Custom Dialog (Compatibility mode)...
Clencal 257 10U 3.5 aUU
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Recommended Reading

THIRD EDITION

* Andrew F. Hayes illustrates each step in an analysis
using diverse examples from published studies, and Introduction to
displays SPSS, SAS, and R code for each example.

Mediation, Moderation,

* Procedures are outlined for estimating and

interpreting direct, indirect, and conditional effects; and COndlthnal
probing and visualizing interactions; testing

BT Analysi
hypotheses about the moderation of mechanisms; OCESS d yS S
and reporting different types of analyses. e essionioased Anpronch

» Readers gain an understanding of the link between

statistics and causality, as well as what the data are
telling them.

g Andrew F. Hayes
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Current Salary by Beginning Salary split by Employment Category
Employment
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Understanding Moderation Analysis
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Moderation Analysis

* A moderating variable is one that interacts with a key independent variable to amplify
or dampen the relationship between the independent and dependent variables

* A moderator variable contextualises an effect by changing the relationship between

an independent variable and a dependent variable. Moderating effects are also
referred to as interaction terms.

* A moderator is not caused by an independent variable
e Examples:

— Does time in employment affect salary progression? Is this relationship moderated
by gender?

— Does study amount affect your essay score? Is this moderated by sleep quality?
— Does advertising spend affect sales? Is this relationship different by quarter?

SMART VISION A SELECT INTERNATIONAL COMPANY
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Moderation Analysis - Graphical Form

—
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Moderation Analysis - Statistical Form

Y — Dependent Variable

X —Independent Variable
M — Moderator Variable
X*M — Interaction between independent and moderator variable

Dependent Constant Independent Moderator Interaction

Y= b, + bX + b,M +bXM

SMART VISION A SELECT INTERNATIONAL COMPANY
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Current Salary by Beginning Salary split by Employment Category
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Beginning Salary

Performing Moderation Analysis in SPSS Statistics
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Moderation Analysis

In the SPSS sample data file, Employee data.sav, there seems to be a strong
relationship between starting salary and current salary

Scatter Plot of Current Salary by Beginning Salary

$80,000 L 2

570,000

560,000

$50,000

Current Salary

$40,000

530,000

520,000

Report
Current Salary
Started as a manager? Mean M Std. Deviation
Mo $2805318 340 §7,363.358
Yes $63977.80 84 5§18 244776
Total $34 41857 474 $17 075661

$10,000
5,000 $10,000 $15,000 $20,000

Beginning Salary

25,000

$30,000

$35,000

Is this relationship moderated by whether the employees started as managers or not?

SMARTVISION
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Moderation Analysis

Current Salary by Beginning Salary by Started as a manager?

$150,000
Started as a
manager?
@ No
@ Yes
—_No
- Yes
$100,000
©
(73]
B
= |
Q
$50,000
50
50 $20,000 $40,000 $60,000 $50,000

Beginning Salary

A SELECT INTERNATIONAL COMPANY

SMARTVISION

-



Moderation Analysis - Statistical Form

* Current Salary (Dependent Variable)

* Beginning Salary (Independent Variable)

e Started as a manager (Moderator Variable)

* Beginning Salary* Started as a manager (Interaction between independent and moderator variable)

Dependent Constant Independent Moderator Interaction

Current Salary = bO + b1 Beginning Salary + b2 Started as amanager + b3 Beginning Salary* manager

SMART VISION A SELECT INTERNATIONAL COMPANY
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Let’'s take a look...

Current Salary

$150,000

$100,000

$50,000

Current Salary by Beginning Salary by Started as a manager?

Startedas a
manager?

@ No
@ Yes
“~No
T~ Yes

20000 $40,000 60,000 $80,000

Beginning Salary
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Understanding Mediation Analysis
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Mediation Analysis

A mediating variable is one that can be used to represent the hidden underlying cause of a
relationship between an independent and dependent variable

* A mediator variable explains why a relationship exists as it provides a reason for the effect
of a given factor upon an outcome of interest

* Most analysts regard a mediator as something that the independent variables causes. The
mediator variable then goes on to influence the dependent variable.

 Examples:

— A new exercise regime may be related to an increase in self-esteem. Is this relationship

mediated by the degree of weight loss that exercise regime causes which in turn
increases self-esteem?

— A researcher discovers that income is related to life expectancy. Is this relationship
mediated by the assumption that those with higher incomes spend more on healthcare?

SMART VISION A SELECT INTERNATIONAL COMPANY
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Mediation Analysis - Graphical Form

, Predictor Outcome
No Mediator - Total Effect -

Indirect Effect

\

C
-
\G Direct Effect
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Our example
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Mediation Analysis

* |s the relationship between education level and current salary mediated by
starting salary?

* A person’s starting salary is likely to be directly related to their education
level

* Therefore, the relationship between education, starting salary and current
salary might look something like:

Education > Starting Salary > Current Salary

* If so, it is reasonable to assume that starting salary may mediate the
relationship between education and current salary

SMART VISION A SELECT INTERNATIONAL COMPANY
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Mediation Analysis - Graphical Form

Total Effect

Current Salary

Indirect Effect O

_ _ O Starting Salary
Mediator included

A

!5
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Let's take a look...

Current Salary

$150,000

$100,000

$50,000

Current Salary by Beginning Salary by Started as a manager?

Startedas a
manager?

@ No
@ Yes
“~No
T~ Yes
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Beginning Salary
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Path A - education predicts starting salary

I T U R I U R I

OUTCOME VARIABLE:

A*B
Indirect Effect

::“-I-.:-::‘--‘
Model Summary A Starting Salary
R R-3q MSE F dfrl df2 p
.6332 .4009 37188762.8 315.8%9¢7 1.0000 472.0000 .0000
i :
Direct Effect
Model

Education Current Salary

coeff se t P LLCI ULCI
constant -6290.9673 1340.9198 -4.€915 L0000 -8925.8785 -3656.05¢€0

educ 1727.5283 97.1969 17.7735 .0000 1536.5360 1918.5206 1727 5283

Path C - Direct Effect — education & starting salary predict current salary

OUTCOME VARIABLE:

Model Summary X = 288951 6

R R-3q MSE F dfl df2 D
.8902 .7924 60785788.0 898.9469 2.0000  471.0000 .0000
Model
coeff se t P LLCI ULCI
constant -7808.7142 1753.8605  -4.4523 .0000 -11255.074 -4362.3545
educ 1020.3901  160.5504 6.3556 .0000  704.9064 1335.8739 1.6726
salbegin 1.6726 .0588  28.4234 .0000 1.5570 1.7883
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Indirect Effect Output

AAKAKNENENEANENLY TOTAT DT

=

- _F _. l. ';' U T T
Total effect of X on Y
Effect se t P LLCI ULCI C Cs

3909.5%067 204.5470 15,1150 0000  3507.9712 4311.8422 . 6606

Direct effect of X on ¥

Effect se t p LLCI ULCI c' cs

1020.3901 1€0.5504 £.355¢ L0000 704.9064 1335.8739 L1724
Effect BootSE  BootLLCI  BootULCI The confidence intervals do

salbegin 2889.5166 228.4900 2451.4110 3353.5845 not contain zero...

...Beginning salary is therefore

G a significant mediator
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Percentage of total effect that the indirect effect accounts for

AAAAXAAAAXAA4% TOTAL, DIRECT, AND INDIRECT EFFECTS OF X ON ¥ *AAaxadaxasirn

Total effect of X on Y
Effect se t P LILCI ULCI c cs
3909.%90e7 204.5470 19,1150 0000 3507.9712 4311.8422 .660¢6

Direct effect of X on ¥
Effect se T P LLCI ULCI c' cs
1020.3901 160.5504 6.3556 . 0000 704.9064 1335.8739 .1724

Indirect effect(s) of X on Y:
Effect BootSE BootLLCI BootULCI 288951 66 — 0739 * 100 — 73.9%

salbegin 2°°0.5166  228.4900 2451.4110 3353.5245  3909.90067
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Full and Partial Mediation

* Full mediation — Path A*B is significant but Path Cis not

e Partial mediation — Path A*B and Path C are significant

A*B
Indirect Effect

/ Starting Salary \

G Direct Effect

SMART VISION A SELECT INTERNATIONAL COMPANY
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The Process macro supports multiple model forms

Model 1 — Y

b
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The Process macro supports multiple model forms

Model 3
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The Process macro supports multiple model forms

N
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Andrew F. Hayes, Ph.D.

Home

My CV.
Workshops
My Books

Teaching and Speaking

Mechanisms and
Contingencies Lab

PROCESS macro for
et Introduction to Mediation, Moderation, and Conditional
SPSS, SAS, and R Macros Process Analysis: A Regression-Based Approach
and Code . -
Third Edition
Video

TR TREEB T 1 o N Introduction to Mediation, Moderation, and Conditional
Skeets Process Analysis describes the foundation of mediation
and moderation analysis as well as their analytical
integration in the form of "conditional process
and Conditional analysis”, with a focus on PROCESS for SPSS SAS, and
R (#processmacro) as the tool for implementing the
methods discussed. Available as both an e-book and

in print form, it is published by The Guilford Press.

Process Analysis

Here are the data files and code used in this third
edition of the book.
Here is the errata for the third edition.

Andrew F. Hayes
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ChatSPSS

< O [ @ nhttps//chatspss.com

<+ NEW CONVERSATION
CONVERSATIONS

How can | remove unwanted LOG output?
How can | remove unwanted LOG output

Whats the difference between ANOVA and
ANCOVA

DOCUMENT REFERENCES
IBM_SPSS_Statistics_Core_System_User_G...
IBM_SPSS_Statistics_Brief_Guide.pdf
IBM_SPSS_Statistics_Base.pdf

IBM_SPSS_Missing_Values.pdf

< i\;@l’ﬁ

EXPORT PDF LOG OUT PRIVACY SMARTVISION [

To remove unwanted LOG output in IBM SPSS Statistics, you can hide the log messages in the Viewer. Here's how to do it:
1. From the menus, choose:
Edit > Options...

2. Click the Viewer tab.
3. Double-click the Log icon to hide log messages in the output.
4. Click OK to save your changes and close the dialog box.

This will hide the log output from the Viewer, helping to declutter your output display.

Whats the difference between ANOVA and ANCOVA?

Difference Between ANOVA and ANCOVA

ANOVA (Analysis of Variance) and ANCOVA (Analysis of Covariance) are both statistical methods used to compare the means of different groups. However, they differ in their approach and application:

* ANOVA: This method is used to compare the means of three or more groups to see if there are any statistically significant differences between them. It does not take into account any other variables that
might influence the dependent variable.

* ANCOVA: This method is an extension of ANOVA that includes one or more continuous independent variables, known as covariates. ANCOVA adjusts the means of the groups based on the covariates, which
can help reduce the error variance and increase the power of the test.

In summary, ANCOVA is used when you want to control for the effects of one or more continuous variables (covariates) while comparing the means of different groups, whereas ANOVA is used when you only want
to compare the means without considering any other variables.

For more detailed information, please consult external sources or the official SPSS documentation.
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Training Consulting
Training notes SPSS Boost Technical support

In person training One-to-one guided consultancy Freguently asked questions

Online self-paced training courses

Meet ChatSPSS - Your Al-Powered SPSS Tutor

Get instant, accurate answers to your SPSS and statistics questions — anytime you need them.

Smart Vision Europe is proud to introduce ChatSPSS, the first Al-enabled tutor designed specifically for SPSS users. Whether you're new to SPSS or an experienced analyst,

ChatSPSS helps you get the very most out of your software, saving you time and boosting your confidence with data analysis.

What can ChatSPSS do for you?

Guide you through loading and preparing data in SPSS
Show you how to summarise results and run statistical tests
Explain outputs from regression models and other advanced techniques

Answer almost any SPSS or statistics-related question, on demand



Smart Vision Europe: Services and Expertise
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We have decades of experience providing guidance, training and
consultancy in the delivery of effective data science initiatives.
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Smart Vision Europe: Other services

* Sourcing Software
— You can buy your analytical software from us often with discounts
— Assist with selection, pilot, implementation & support of analytical tools
— http://www.sv-europe.com/buy-spss-online/

* Training
— Formal classroom/virtual training
— Online self-paced training resources
* Advice and Support
— ‘No strings attached’ technical and business advice relating to analytics
— Tracked technical support services around the IBM SPSS product line
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Contact us:

+44 (0)207 786 3568
info@sv-europe.com
SMARTVISION Twitter: @sveurope €
E u r o p e Follow us on Linked In ®
Sign up for our Newsletter

Thank you
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